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The E-mail Implementation Team is working with the

membership of ITMC (Information Technology

Managers Council) and NMG (Network Managers

Group) to develop "User Profiles" for every location

in the state where an agency has offices.

Some of the information to be collected is:

the exact location of the office

the state of the hardware — how close is that

location to being 32-bit ready? (Locations that are

32-bit ready will be given priority over those

running 16-bit systems.)

the network operating system used

the current ZIP! gateway used

and the way e-mail and calendaring is currently

used within that location (Does the traffic stay

within the workgroup at that location? Does the

traffic stay within the agency? Are appointments

scheduled with others in different locations?)

Training liaison, technical contact and agency

technical support for e-mail

The information will be collected in an Oracle database

accessed through ISD's Web site http://www.state.

mt.us/isd/planning/index.htm.

The information will be used during the planning

phase. It will help the Team determine where to locate

the Exchange servers, the configuration of the server

needed at each location, where communications lines

will need to be upgraded, remote user needs, and, pilot

groups and deployment schedules.

For more information on the Exchange

implementation, contact Wendy Wheeler of the Policy,

Development & Customer Relations Bureau at

444-2856, ZIP! or e-mail at wwheeler@mt.gov.
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Project Uision Statement

The State of Montana will establish

the foundation for a mission critical

messaging system enabling effective

electronic business communication.
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Certification Authority and Digital bignatures

In the last issue of ISD Neil's <& I lews, information

was provided about cryptography. In the public-key

type of cryptography, there are two keys generated,

one public and one private. The public key is used to

encrypt the data while the private key is used to decrypt

the data. The public key can be shared with anyone.

The private key gives the user the ability to read the

data that was encrypted with the public key. This type

of cryptography needs to have the ability to confirm

that a public key belongs to a certain individual. A
third party called a Certification Authority completes

this confirmation.

A Certification Authority (CA) is an organization that

provides the secure and trusted mathematical

computations resulting in a unique digital certificate

for an individual that cannot be duplicated. A
certificate is basically a CA's signature of an individual's

public key. It usually contains either the name of a

person or an organization, their public key, the CA's

signature of the key, and an expiration date. The

standard for these certificates is referred to as X.509.

Digital certificates or IDs are the electronic

counterparts to membership cards, driver's licenses,

and passports. They establish an individual's identity

in the electronic world just as these traditional

credentials identify an individual's identity in the

physical world. There are several different types of

digital IDs available. The different types carry different

information and require different levels of

authentication. For example, it is fairly easy to obtain

a membership card for a local discount warehouse,

but to get a passport, you must provide substantial

proof of identity, such as a notarized copy of a birth

certificate. Obtaining a Class 1 digital ID is fairly easy,

the user only needs to provide an e-mail address, but

obtaining a Class 3 digital ID requires that the user

provide substantial proof of identity.

Digital IDs enable the use of digital signatures, which

are necessary to conduct much of the electronic

commerce that is becoming common in today's

electronic environment. Digital signatures provide

verification that information originated from the

person who sent the information and the information

has not been altered since leaving the sender.

A CA basically guarantees that people and

organizations are authentic and reliable. It provides a

way for trusted relationships in networks that are not

secure, such as the Internet.

For more information regarding certification

authorities and/or digital signatures, contact Lynne

Pizzini, Network Security Officer at 444-4510, ZIP!

or e-mail at lpizzini@mt.gov.

www.statejnt.us/isd/cuprent/news/index.htm

Calendar of Events

(Day 6

Information Technology Managers Council

(ITMC) 8:30-1 0:30am, Rrn 111, Metcalf Bldg.

(Day! 1
)

9-1-1 Advisory Council

9am- 12pm, Rm 108, Capitol Bldg.

Illay 21

Public Safety Communications Council

9am-3pm, Location TBA

may 21

Information Technology Advisory Council (ITAC)

8:30am- 12pm, Rm 1 1 1, Metcalf Bldg.

(Hay 28

Summitnet Executive Council (SEC)

1:30-4 pm, DPHHS Auditorium-METNET Site

June 3

Information Technology Managers Council

(ITMC) 8:3(l-10:30am, Rm 1 I 1. Metcalf Bldg
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ITICTnCT Interactive Uideo ISO IDBGSTflR Treh

• An increase in usage, new equipment on the horizon,

expanded alliance utilization, and our web site,

highlight the news for the METNET Interactive Video

System. University level classes have increased their

reach by using METNET, and additional state agency

and judicial uses are making the system a useful asset

to Montanans. The current monthly average is 105

conferences, with billings of 250 to 350 hours. A few

years ago it was 10 to 25 hours a month.

METNET has 14 official sites, but thanks to team

work, there are now alliances with four telemedicine/

telepsychiatry networks, allowing access to 18

additional communities in Montana.

Until last fall, all METNET video locations were

equipped with Compression Labs, Inc. (CLI)

compressed digital video products. VTEL Corporation

and CLI have merged, retaining the name VTEL.

For now, METNET technicians will be installing

VTEL systems to expand or upgrade. The new
VTEL systems, and the support that Williams

Communications Solutions and VTEL have, exceed

our expectations. VTEL equipment is high-end PC
based, and can easily upscale to the new service

offerings that are envisioned in the future.

The METNET Interactive Video Web page is a

valuable resource to our users and potential users. You

can find it on the Web at http://www.state.mt.us/

isd/metnet/index.htm . It can be used to

find where our sites are located

6nd our pricing structure

find what our network is like

In the future, our site can be used to find out about

courseware and informational video conferences. It

could become a good tool for educators and public

servants to get their "products" advertised. (Carried

on METNET)

For more information contact Rick Wine of the

Telecommunications Bureau at 444-3517, ZIP! or

e-mail at rwine@mt.gov.

Montana Educational Telecommunications Network

flews

ISD has purchased and installed an IBM 3590

MAGSTAR tape drive unit for the state mainframe.

With a name like MAGSTAR, you know it has to be

something beyond the ordinary. Indeed, it is. The

MAGSTAR unit is part of the IBM 3590 High

Performance Tape Subsystem. Its highlights are high

storage capacity and enhanced performance

capabilities.

This subsystem is a continuation of the service

provided by the 3490E subsystem that ISD has had

in production for several years. Nonetheless, there is

no physical compatibility between the two. A 3480/

3490 cartridge cannot be loaded into a 3590 drive,

nor can a 3590 cartridge be loaded into a 3480/3490

drive. However, data can be transferred between the

3590s and any other I/O device connected to the

mainframe.

Considering the physical shape and size of the 3590

cartridge is about the same as 3490 cartridge, the

storage capability of a 3590 cartridge is pretty amazing.

The cartridge is written in a 128-track format as

opposed to the 36-track format of the 3490E

cartridge.

The 3590 drive will actually write 16 tracks at a

time, making four "round trips" from physical

beginning to physical end of tape and back again.

Given this number of tracks available, the 3590

cartridge can hold 10GB of uncompacted data

and 30GB of compacted. This compares to 2.4GB

of compacted data on a 3490E cartridge. All of

this on about 300 meters of media shoved into a

4" x 5" cartridge less than one inch thick!

With all this storage you might think it would take

forever to transfer all that data to the cartridge. It will

take some time, but not as long as a 3490E. The 3590

MAGSTAR subsystem will read and write data at 9

MG/second, a rate three times faster than the 3490E.

This is reading or writing about 16 tracks of

information at two meters of media per second.

The enhanced storage capacity of the MAGSTAR
system can be beneficial in several areas. Assuming

that each cartridge is being filled with data, the floor

space required to store a tape library is cut up to 75%.

Virtual tape storage becomes a possibility, complete

with "lights out" tape processing where the cartridges

are kept in storage silos and loaded into the drives by

o Uiews
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a robotic device. Vaulting becomes less of a hassle

since fewer cartridges will need to be stored and

tracked. WTiile none of these changes have taken place,

they will be considered as the MAGSTAR usage

increases.

What type of application would be a good MAGSTAR
candidate? High capacity cartridges serve no purpose

if they are not filled. A 10GB cartridge is no better

than a 2.4GB if it contains only 1GB of data. So a

good candidate would be one with very large data

requirements, for example, an application which

creates a dataset which fills two or more 3490E

volumes. Stacking frequently accessed files on a large

capacity cartridge might not be a good use. Other non-

mainframe platforms can be backed up on the

MAGSTARs, affording the user all the safeguards and

conveniences of the mainframe tape management

system.

To date, the ISD MAGSTAR unit is dedicated to

backing up the files on the State of Montana
MTPRRIME mid-tier computer. However, as the need

arises, current and future units will be available for

applications needing the enhanced storage capabilities.

For more information contact Bill Ramsay of the

Computing Operations Bureau at 444-2902, ZIP!, or

e-mail at bramsay@mt.gov.

ITdlC Approves [lew Database Standards

The Information Technology Managers Council met

April 1, 1998 and took action on two major issues.

Desktop Database Subcommittee Recommen-
dations. The Council received a report outlining the

recommendations of the Desktop Database

Subcommittee. The recommendations follow:

1

.

Microsoft Access become a state standard

desktop database

2. Microsoft Visual Basic become a state standard

programming language

3. Lotus Approach remain a state standard

desktop database

The subcommittee also prepared guidelines for the

appropriate selection and use of the state standard

databases and application development tools based

on criteria such as need for enterprise access, mission

criticality, number of users and the size of the database.

The recommendations were approved unanimously.

A full copy of the subcommittee's report is located

on the ISD Value Added Server (VAS) at guest\

itmcinfo\recommend.wpd.

Recruitment and Retention Subcommittee
Report. The Subcommittee presented its Report on

Recruitment and Retention of State Information Technology

Professionals to the Council for its endorsement before

submitting it to Lois Menzics, Director of the

Department of Administration. The report makes

four recommendations:

dews

1. Retain Pay Exception for IT
Positions. The pay exception issued in

September 1997, to address retention problems

for existing employees, should remain in effect.

2. Implement Immediate Grade Level Adjust-

ments. Losing the existing pay plan, IT employees

could be granted a salary increase equivalent to

one pay grade.

3. Develop and Implement a Market Based IT

Broad banded Pay Plan. Based on efforts

currently underway in the State Personnel

Division, a broad banding IT pay system should

be researched, developed and implemented

4. Study Additional Strategies for Recruiting

and Retaining IT Professionals. Study and

propose additional improvements in the state's

employment package in the areas of recruitment,

benefits, work environment, career development

and recognition.

The Council unanimously endorsed the report. Full

copies of the report may be found on the ISD VAS at

guest\itmcinfo\recr&ret.sub\ret&rec.wpd.

In other business, the Council received an update on

the MT PRRIME project from Jim Sheehy; an update

on the Exchange e-mail project from Wendy Wheeler;

information from Mike Randall on how ITMC will

be involved in the ITAC strategic planning process

and more. Minutes of the meeting are available on

the ISD VAS at guest\itmcinfo\minute98 or from

Kim LaRowe (klarowe(5 rnt.gov) of ISD al 444 2700.

Uiews
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Oracle Designer/2000 Overview

Designer/2000 is a powerful application design

tool used for process modeling, analysis modeling,

designing and generating Oracle applications.

Designer/2000 provides the user with toolsets

designed for analyzing business requirements and

building systems that meet a department's needs.

There are five basic toolset groups that developers

need to be familiar with.

1. The Process Modeller is a graphical model

used for illustrating a business process. It can

support sound files, movies, and bitmaps. It

also supports timelines and will determine a

critical path for a set of processes.

2. The Systems Modeller gives a detailed

description of the department requirements

with the use of the entity relationship

diagrammer, the data flow diagrammer and the

function hierarchy diagrammer.

3. The Systems Designer records a detailed

description of the system design. The
environment it creates is developed for system

engineers and/or designers.

4. The Generator products (Forms, Reports and

Server) use the definitions recorded in the

Repository and create complete systems

comprising server-side components and client-

side applications.

5. The Repository Administrator is a tool used

to install, upgrade and maintain the repository

of application information. The Repository

Object Navigator (RON) is a graphical

browser used for definitions. The RON
defines the business units in an organizational

chart. It also records details of objectives, aims,

critical success factors and key performance

indicators for the business units. The Matrix

creates grids to show relationships between

objects in the repository.

The diagram gives a step by step example of how
Designer/2000 is implemented. Some steps may

be omitted depending on the business

requirements and its users. For example, some

applications may not require the Process ModeUer

and its illustrating abilities.

There are Designer/2000 Media Based Training

courses available. For more information, see the

MBT article in this issue.

For information or assistance on using Oracle

Applications, contact the Systems Support Bureau;

Barry Fox at 444-5895, ZIP! or e-mail at

bfox@mt.gov; Steven St. John at 444-2910, ZIP!

or e-mail at sstjohn@mt.gov; Tony Noble at 444-

2922, ZIP! or e-mail at tnoble@mt.gov.

Systems Generation
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ZIP! Tips * Proper Format for Attachments

The ability to send files via e-mail is vital to state

government business. With the rollout of Microsoft

desktop software products, you may be receiving Word

and Excel files along with WordPerfect and Lotus

documents. With different document versions being

created among various agencies, it is imperadve that

everyone sends documents that can be read by the

recipient to maintain the integrity of e-mail's

capabilities. Therefore, until everyone is converted to

the same product, you should use a format that you

know the recipient can handle. If you are unsure, or

if you are sending to a mixed audience, it's probably

best to attach two copies (both old and new formats).

Many users, viewing Word files in ZIPIOffice, may

notice it displays quite differendy than how it would

in Word. Your e-mail package's role is to send the

document from one user to another.

ZIP!Mail/ZIP!Office's viewer attempts to

display the file for your viewing. However,

the viewer is simply displaying what it was

able to translate from the document and

consequendy can not interpret some (or all)

of the formatting codes. Some files simply

can't be viewed in ZIP!. In these cases, you need to

copy the file to a DOS subdirectory and open it in the

corresponding software package. To do this, highlight

the attachment in your intray Click on Edit, then Copy
to DOS file. The window below appears.

In this window, you can choose where to store the

file. To retrieve it, open the software package the file

was created in and view, edit or print it from there.

Remember, even though ZIP! has some capabilities

that may allow you to view the document, it is NOT a

word processor. We'll investigate different options

during the testing phase of the Microsoft Outlook

rollout as we look at coexistence requirement options.

If you have any questions on exchanging files via ZIP!,

contact Sue Skuletich of the Systems Support Bureau

at 444-1392 ZIP! or e-mail at sskuletich@mt.gov.

K^n FTxl

File name:

ffry^wrffti

ate! may.doc
ceit_a *»pd

contract wpcl
corei.doc

diagram, til

Folder*:

s:\pdr\custfel\nlv\articles

_j|s:\

jpdi

_J custiel

_j nlv

ij articles

I
archives

Help

Network..

Save lite as type:

All files ('.')

Drives:

|
-jJ s: Wdoa_isd_004Wol1J

Sending Attachments to Internet Users

We've been experiencing problem calls regarding

the ability to send attachments to Internet users.

When preparing to send an attachment, you must

fill in the subject line, the body of the message

and add the attached file before sending. If you

neglect to fill in any text in the body, you will

receive a ZIP! message containing the following

error:

Sender: docj@mt.gov

Sendto: -SMF71-@INTERNET.mt.gov
Error: Authoritative name error

Status: Reported by name server 1 61 .7.21 8.10

Delivery of the message has been cancelled

The Internet gateway cannot handle an attachment

unless there is text in the body. This text message

can be as simple as "Enclosed is the XYZ
document" Without any text, you can expect a

ZIP! error every time.

For additional information or questions regarding

ZIP!, please contact Lisa Carson of End User

Systems Support at 444-1542, ZIP! or e-mail at

lcarson@mt.gov.

Hems ° Uiews
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ZIPIOffice Sending

$ Internet G®mail

Awhile ago, functionality was added to ZIPIOffice to

allow users to easily send and receive Internet mail.

Your Internet address book holds all your Internet

mail addresses, and you're not required to use MHSTO
lines. MHSTO lines are more prone to user error, and

your Internet address book will be easier to use.

i

From the edit menu, you can select "Add address"

and enter the names and address of people you

communicate with.



Personal Office Assistant

As more people begin to use the Microsoft Office

products, they will notice several new Office Assistants

running around the office. No, these Assistants are

not new staff—they are the Office Assistants that

come with the new Microsoft Suite! The Office

Assistant provides Help topics and tips to help you

accomplish your tasks. If your Office Assistant is not

displayed, simply click on the icon at the end of your

Standard toolbar that looks like the icon shown below.

The following tips will help you get

along with your new Assistant that will

be sharing your PC with you.

wGet Help. Tips, and messages

through the Office Assistant

The Office Assistant can answer your questions, offer

tips, and provide Help for a variety of features specific

to the Office program you are in. The Assistant can

display:

Suggested Help is relevant to the specific task

you are performing and appears before you even

ask for Help. For example, if you click the

Assistant while you make changes to a table

—

with this option selected—the Assistant returns

Help topics about how to work with tables. Help

with wizards appears when you start a wizard.

If you don't want Help, you can turn off Help

with wizards.

Tips point out how to use the features or

keyboard shortcuts in the program more
effectively. A tip is available when a yellow light

bulb appears in the Assistant. Just click the light

bulb to see the tip. If the Assistant is not visible

when a tip arrives, the Office Assistant button

displays a light bulb. Click Office Assistant to

display the Assistant, and then click the light bulb

to display the tip.

Messages appear in the Office Assistant when it

is turned on. You can choose to see your messages

in the Office Assistant balloon or in a different

dialog box.

All the Office programs share the Office Assistant.

Any Assistant options you change, such as the types

of tips the Assistant displays, affect the Assistant in

all the Office programs. To display the Assistant after

you display a Help topic, click anywhere in the Word
window, or close the Help topic.

Help without Office Ossistant

To get Help without the Office Assistant, choose

Help, and then click on Contents and Index. To

display Help without the Office Assistant when you

press Fl, click Options. (If the Options button is

not visible, click the Assistant, and then click Options.)

On the Options tab, clear the Respond to Fl key

check box.

Hide or show the Office Assistant

To show the Office Assistant, click Office

Assistant. Simply click on the icon at the end of

your Standard toolbar that resembles the icon

shown above.

To hide the Assistant, click the Close button on

the Assistant.

How to Calm a Distracting Office Assistant

Some Office Assistants are more active than others.

To choose a different Assistant, right-click the

Assistant, and then click Choose Assistant on the

shortcut menu. On the Gallery tab, click Back or

Next to see the available Assistants. The Office Logo

Assistant is the least active. The Assistants that are

the most active and have the most frequent sounds

are The Dot and PowerPup.

To limit Office Assistant movements around the

screen, click the Assistant, and then click Options.

On the Options tab, clear the Move when in the

way check box.

To turn off Office Assistant sounds, click the

Assistant, and then click Options. On the Options

tab, clear the Make sounds check box.

The ( )ffice Assistant has two sizes. To change the size,

position the mouse pointer over any Office Assistant

news o Uiews



border until the pointer changes to a double-headed

arrow. Drag the border to the size you want. To have

the Assistant automatically change from the large to

the small size after 5 minutes not in use, click Options.

(If the Options button is not visible, click the Assistant,

and then click Options.) On the Options tab, select

the Move when in the way check box.

Haumg the Office Assistant show the Help

topic you want

If the Office Assistant is not showing, click Office

Assistant.

For best results during a search for a Help topic,

type a complete sentence or question, rather than

a single word or phrase, in the Assistant. For

example, to find Help on how to print more than

one copy of a file at a time, type Print more than

one copy at a time, not print.

The Office Assistant only displays product Help

topics when you are in the non-programming part

of the product. And the Assistant only displays

programming Help topics when you are in the

programming part of the product.

To search for both product and programming Help

topics while you are in the programming part of the

product, click the Assistant, and then click Options.

On the Options tab, select the Search for both

product and programming Help when
programming check box.

To display the Assistant after you display a Help topic,

click anywhere in the Word window, or close the Help

topic.

These are just a few tips to help you in your use of,

and your conversion to, the new Microsoft products.

Other tips can be found by consulting your Office

Assistant. For more information concerning this

article, contact Irvin Vavruska of End User

Systems Support at 444-6870, ZIP!, or e-mail at

ivavruska@mt.gov. For questions about the new
Microsoft Office Suite, please contact your agency

support staff, your Office Assistant, or the ISD
Customer Support Center at 444-2000.

Ulicrosoft Office 91

The State has chosen Microsoft Office 97 Suite

as the new desktop software standard, and has

begun the process of rolling out this software

to all desktops. Not everyone has Office 97 and

its associated programs, and won't for some

time. The movement of all state users to the

Suite will take up to two years, with individual

agencies moving at different rates and at

different times. Until all users have been

moved to Office, it is

important that users File conversions

who have it restrict the work for simple,

use of Word, Excel, or
gmall ffleSj bm

PowerPoint. Userswho
, . ~ cc there are major

currently have Office

97 installed should limit
difficulties in

themselves to using the converting large

Office applications or advanced

only to create files that feature files.

are not going to be

shared outside their

organizational unit, assuming that all users in

their unit have Office 97 as well. This is

necessary because file conversions between

Word and WordPerfect; Excel and 1-2-3; and

PowerPoint and Freelance; work for simpler

smaller files, there are major difficulties in

converting files that are large or use advanced

features. For details on these problems, check

in the Help options for each Office application,

or in the Office 97 Resource kit.

There are also problems with ZIPIOffice and

its lack of support for viewing Word file

formats. See the article on ZIP! and file formats

in this month's issue of ISD New <& Views.

Be sure to contact your supervisors to arrange

attendance at Office 97 training at the Helena

College of Technology.

If you have questions about this article contact

Denny Knapp of End User Systems Support

at 444-2072, ZIP! or e-mail at dknapp@mt.gov.

If you need technical support contact the ISD

Customer Support Center at 444-2000.

Dews ° Uieuis
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WordPerfect fllacros to Microsoft Word
Converting Using Uisual Basic for Applications Part 1 of 5

This article describes the methodology, approach, and

requirements for converting macros developed for

various versions of WordPerfect to Visual Basic® for

Applications in Microsoft® Word. Because of the

complexity of macros, there's no automatic conversion

utility available for converting macros from

WordPerfect to Visual Basic for Applications. This

document will help you understand the differences

between the programming languages used by

WordPerfect and Word, and how to successfully re-

record or rewrite your WordPerfect macros for use

with Word.

Some basic familiarity with both WordPerfect and

Word is assumed. This article doesn't describe the

principles of programming for either WordPerfect or

Word. If you aren't familiar with the Word or

WordPerfect programming languages, you should

learn basic concepts of each language before

attempting to convert your WordPerfect macros.

This article provides only a rudimentary discussion

of programming using Visual Basic. You may want to

augment your study of Visual Basic using Microsoft

Office 97 Help.

Supported Uersions

WordPerfect's macro language differs from version

to version of WordPerfect. This document describes

converting macros from two WordPerfect versions:

WordPerfect 5.1 for DOS, and WordPerfect 6.1 for

Windows. If your WordPerfect macros are from a

different version of WordPerfect, you may still be able

to convert them, but there may be issues to consider.

The macro language in WordPerfect 5.0 for DOS
is identical to that in WordPerfect 5.1 for DOS,

except it contains fewer commands. For all

practical purposes, a WordPerfect 5.0 for DOS
macro can be considered the same as a

WordPerfect 5.1 for DOS macro.

Versions prior to WordPerfect 5.0 for DOS lacked

a programming language, and are therefore not a

topic of interest in this document.

WordPerfect versions 6.0 and 6.1 for DOS use a

different macro language than WordPerfect 5.1

for DOS and WordPerfect for Windows.

Conversion from WordPerfect 6.0 and 6.1 for

DOS are not detailed in this document.

WordPerfect versions 6.0, 6.1, and 7.0 for

Windows are identical except for slight variations

in syntax and command availability. For the

purposes of this document, they are considered

to be the same version.

WordPerfect 5.1 and 5.2 for Windows uses a now-

abandoned macro programming dialect. While the

language is similar in some respects to the macro

language of WordPerfect 6.1 for Windows, there

are substantial differences in the command syntax.

For this reason, and since these versions haven't

been commercially sold for years, converting

macros from WordPerfect 5.x for Windows is not

detailed in this document.

Introduction

Macros are commonly used for automating office tasks

— using desktop applications to do more in less time.

Typical automated office tasks are inserting common
blocks of text into documents, formatting documents

in a specific style, and automatically assembling larger

documents from smaller documents.

Unlike documents, which can often be converted

between different word processors using a conversion

"filter," macros are really miniature programs and

cannot be readily converted. If you have macros that

you've recorded or written for WordPerfect, they'll

need to be re-recorded or rewritten for use with Word.

The difficulty in re-creating automated WordPerfect

office depends on the complexity of the original

macros. Simple macros are easy to re-create in Word.

Word 97 includes Visual Basic 5.0, a sophisticated

development environment that is shared across Office

applications: Word, Microsoft Excel, Microsoft

PowerPoint, and Microsoft Access. Visual Basic is also

part of the Microsoft Visual Basic product and

Mcrosoft Project. Visual Basic is also licensed to other

software companies. Visual Basic goes beyond being

merely a macro language - it is a full-featured

programming development environment. Throughout

this document, we'll refer to "macros" in Word as

Visual Basic code.
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The Conversion Process

Converting macros from WordPerfect to Visual Basic

is a six-step process.

1

.

Examine the purpose of the WordPerfect macro.

2. Determine if a macro is needed, or if Word can

handle the job using another built-in feature, such

as AutoText or forms.

3. Chart the flow of the macro to define its

important routines.

4. In Word, record one or more macros that

duplicate the functionality of the original macro.

5. If necessary, modify the recorded macros and

manually add additional programming
instructions where necessary.

6. Test the finished Visual Basic code.

Step 1: Examining the Purpose of the Macro
You must fully understand the purpose of the

WordPerfect macro before it can be successfully

converted. If possible, run the macro on a copy of

WordPerfect or view the macro in WordPerfect's

macro editor. This will give you a better understanding

of what the macro does.

Take note of any documents that the macro uses or

produces. Word versions of these documents may be

needed when the macro is converted to Visual Basic

Step 2: Determine if a Macro is Needed
Sometime it's not necessary to replicate a WordPerfect

macro in Word, especially if the macro performs a

rudimentary formatting function, such as applying

bold and underlining to text (this task can be easily

handled using Word styles). The Word interface and

other features, make many of these simple macros

unnecessary. See the "Deciding When a Macro Isn't

Needed" article in a later issue of ISD News& Views.

Step 3: Chart the Flow of the Macro
Simple macros do a specific job and nothing more.

Complex macros may perform several tasks in a

particular order depending on external conditions. If

a macro performs a number of steps during its

execution, create a simple flowchart that outlines each

step. Include any pauses in the macro for user input,

such as answering Yes/No questions or typing text.

The instructions that create these pauses need to be

manually added to the recorded Word macro.

Step 4: Record Duplicate Macros in Word
There are hundreds of properties, methods and objects

available in Visual Basic. Learning them all is a daunting

task. The most time efficient approach to macro

conversion is to record duplicates of your WordPerfect

macros using Word's macro recorder. You can view

the Visual Basic instructions, which can be assembled

into larger macros, using copy and paste.

Step 5: Modify the Recorded Macros

You can use your recorded Word macro as-is or use

the code to build larger macros. You may need to

record short segments that duplicate the original

functionality of the WordPerfect macro, and then

combine these instructions with additional instructions

you manually add to build the finished macro. For

example, you may add instructions that prompt a user

for input, such as asking if the user wishes to perform

a certain task.

For more information on recording macros in Word, __,

see "Revising recorded Visual Basic macros" in Word ^2,

Visual Basic Help (use the Find tab to locate the topic). sas

Step 6: Test the Finished Product j2

Test your new Visual Basic code to make sure it "

duplicates the functionality of the original WordPerfect

macro. If the WordPerfect macro created a document

or some other output, compare the output generated

by Word with the output generated by WordPerfect.

Note: While you're converting macros to Visual Basic,

look for ways to make them better. This is especially

valuable when converting WordPerfect for DOS
macros. WordPerfect for DOS imposed a number of

restrictions on macro programmers, such as limited

access to disk and file services, only two documents

open at once, and no built-in user interface tools like

message boxes. Visual Basic doesn't have the same

limitations. Before converting your WordPerfect

macros, consider adopting the new features and

functionality available in Visual Basic.

This article adapted from Microsoft Technical support

documentation.

For more information about this article, contact Jerry

Kozak End User Systems Support at 444-2907, ZIP!

or e-mail at jkozak@mt.gov. For user support, contact

the Customer Support Center at 444-2000.
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Converting Lotus l°2°3 to Gxcel 91

Parti

There are general differences between Microsoft Excel

97 and Lotus 1-2-3. This series of articles contain

information on the following topics:

1. Converting Worksheets

Limitations of Converting Worksheets

2. Formulas

General Syntax Differences

Formula Calculation Behavior

Mathematical Order of Precedence

3. Worksheet Functions

Differences Between Lotus 1-2-3 and Microsoft

Excel

Microsoft Excel Equivalent Functions

Microsoft Excel Functions That Have No
Equivalent

4. Moving Around the Worksheet

5. Linking Lotus 1-2-3 and Microsoft Excel

Worksheets

6. Macro Compatibility

Converting worksheets between Lotus

l°2°3 and Microsoft Excel

To open a Lotus 1-2-3 file in Microsoft Excel, use the

following steps:

1. On the File menu, click Open.

2. In the Files of type box, click Lotus 1-2-3 Files

(*.wk?).

3. In the Look in box, double-click the drive or folder

that contains the workbook.

4. Double-click the workbook.

Limitations of converting

Lotus l°2°3 files to microsoft Excel

Microsoft Excel 97 cannot open a Lotus 1-2-3

worksheet that is protected with a file-level password.

However, Microsoft Excel can open a file that is

protected at the worksheet level. For additional

information, please see the following article in the

Microsoft Knowledge Base: "Cannot Import

Password Protected WK3 or WK4 Files." (http://

www.microsoft.com/support/)

Lotus 1-2-3 version 5.0 for Windows allows you to

export your files as Microsoft Excel (.xls) files.

However, Microsoft recommends that you use the

converter provided with Microsoft Excel to read Lotus

1-2-3 worksheets. After you open the worksheet, save

it in the Microsoft Excel format.

When you open a Lotus 1 -2-3 worksheet or workbook

in Microsoft Excel 97, Microsoft Excel applies the

formatting in the associated .fmt, .fin3, or .all file. Be

sure the associated .fmt, .fm3, or .all file is stored in

the same folder as the .wk? file. If you save a Lotus

1-2-3 file in the Microsoft Excel format, Microsoft

Excel saves the spreadsheet data and formatting in a

single workbook file.

You can convert multiple Lotus 1-2-3 files to the

Microsoft Excel format by using the File Conversion

Wizard. To use the wizard, point to Wizard on the

Tools menu and click File Conversion Wizard. If this

command is not listed, install the File Conversion

Wizard add-in.

Conversion Notes: When you open a Lotus 1-2-3

worksheet in Microsoft Excel, the Transition formula

evaluation and Transition formula entry check boxes

(click Options on the Tools menu) are automatically

selected for that sheet. This ensures that Microsoft

Excel calculates the formulas according to the listed

Lotus 1-2-3 behavior. These options also allow you

to type formulas with the @ symbol. For additional

information, please see the following article in the

Microsoft Knowledge Base: "How Transition Formula

Entry Affects Behavior in MS Excel."

If you save a Lotus 1-2-3 worksheet in the Microsoft

Excel worksheet format, the Transition formula

evaluation and entry check boxes remain selected for

that workbook until you clear them.
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Formulas

You can open Lotus 1 -2-3 files in Microsoft Excel 97;

however, Microsoft Excel calculates some formulas

and functions differently from Lotus 1 -2-3. Also, you

use a different syntax when you create a formula in

Mcrosoft Excel.

General Syntax Differences

In Microsoft Excel, start a formula with an equal

sign. As in Lotus 1 -2-3, you can also start a formula

with a plus sign or a minus sign.

Although it is not required, you can also type an

@ sign before a Microsoft Excel function.

In Microsoft Excel, use a colon to denote a range

of cells. In Lotus 1-2-3, use periods.

Formula Calculation Behavior

Microsoft Excel calculates formula and database

criteria differendy from Lotus 1-2-3. However, you

can force Microsoft Excel to calculate formulas as

Lotus 1-2-3 does.

To calculate formulas the way Lotus 1-2-3 does, use

the following steps:

1

.

On the Tools menu, click Options.

2. Click the Transition tab.

3. Click Transition Formula Evaluation, then OK.

Note: The Transition Formula Evaluation check-box

is not automatically selected when you open a Lotus

1-2-3 file in Microsoft Excel.

Calculation Differences

In Lotus 1-2-3, when a cell that contains text is used

in a formula, Lotus 1-2-3 assigns a value of (zero)

to the cell. In Microsoft Excel, you cannot combine

text and numeric entries in the same formula.

However, when you use a worksheet function in

Microsoft Excel, Microsoft Excel assigns a value of

for cells that contain text. For example, if you clear

the Transition Formula Evaluation check box, and you

type text in cell A10 and the value 100 in cell BIO; the

formula =A10+B10 returns the error value #VALUE!
However, the worksheet formula =SUM(A10,B10)

returns the value 100.

Lotus 1-2-3 evaluates Boolean expressions to or 1

and displays or 1 in the cell. For example, in Lotus

1-2-3, the expression 2<3 displays 1 in the cell to

represent True; Microsoft Excel displays TRUE or

FALSE in the cell. If you select the Transition Formula

Evaluation check-box, Microsoft Excel displays for

FALSE and 1 for TRUE.

Database criteria ranges are evaluated differentlywhen

you extract data, find data, and use database functions.

For example, the criteria "John" finds only rows with

cells that contain "John." If you clear the Transition

Formula Evaluation check box, the criteria "John"

finds any rows that contain cells with values beginning

with "John"; for example, cells that contain "John,"

"Johnson," and "Johnsen" are found.

Some functions, including @MOD, @VLOOKUP,
and @HLOOKUP, are evaluated differendy. For

example, the @VLOOKUP function in Lotus 1-2-3

looks for an exact match in the first column; the

VLOOKUP worksheet function in Mcrosoft Excel

assumes the first column is sorted and finds the closest

value in the first column without exceeding the lookup

value. The VLOOKUP and HLOOKUP worksheet

functions in Microsoft Excel include a fourth

argument, range_lookup. If you set this argument to

FALSE, Microsoft Excel looks for an exact match.

Caution: Avoid alternately selecting and clearing the

Transition Formula Evaluation check box. If you do

this, the values calculated on your worksheet may be

changed.

If you have any questions regarding this article contact

Brian Divine of End User Systems Support at 444-

2791, ZIP! or e-mail at bdivine@mt.gov. If you need

user support, please contact the Customer Support

Center at 444-2000.
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Conuertmg WordPerfect 6.1 to Word 91

Label and Data files

It's official, as most of you know, we will be moving

our desktop applications to Microsoft's Office 97. This

is the first in a series of articles that will help you

make the transition from our old desktop standards

to Office 97. This article will focus on WordPerfect

Label and Data files and will be divided into two parts:

Part I: Converting WordPerfect Labels

to a Word Data Document

Part II: Using the Mail Merge Feature

to Create Labels.

In WordPerfect, labels use a custom paper size. This

custom size makes it tricky to use WordPerfect labels

in Word. This article will help you quickly convert

these WordPerfect labels into a Word data document.

After you create the Word data document, you can

use the Mail Merge feature to create labels in Word.

Let's start by assuming you have already created a label

document (*.DAT) in WordPerfect 6.1, and now you

are working in Word 97. When you open a

WordPerfect label document (the *.DAT file) in Word,

it will resemble the following

Namef
Address^

City, State-ZIPH

Page Break

Name^[

Address^!

City, State—ZIP1

Page Break

If

Note: If you do not see the paragraph symbols, click

on the Show/Hide button on the Standard toolbar.

To modify this converted WordPerfect document so

that you can use it to create labels in Microsoft Word,

use the following steps:

1. With the converted WordPerfect document

visible, click Replace on the Edit menu. The
Replace dialog box will appear.

2. In the Find What box, type ~p (to create the
A

character, press SHIFT+6). In the Replace With

box, type ^t, and then click Replace All.

This step replaces all the paragraph marks in the

document (designated by ^p) with tabs (designated

by "t). When Word finishes making these

replacements, a dialog box appears stating how

many replacements were made. If you have Office

Assistant running your message will come from

the Assistant.

3. Click OK, if you don't have Office Assistant

running or if you have Office Assistant running,

click on the Find & Replace dialog box.

4. In the Replace dialog box, in the Find What box,

type ^b. In the Replace with box, type ^p, and

click Replace All. This step replaces all of the

manual section/page breaks (designated with ^b)

with paragraph marks.

5. When Word makes all the replacements, click OK
then Close, or if you have Office Assistant active,

just click on Close in the Find & Replace dialog

box. The data will now look similar to the

following

Name > Address > City, State > %
Name > Address > City, State > If

6. On the Edit menu, click Select All.

7. On the Table menu, click Convert Text to Table.

The Convert Text to Table Dialog box will open,

8. Select Separate Text at Tabs, the number of

columns should change to reflect the number of

fields in each record. Click OK
9. Click the mouse button to clear the selection.

10. Place the insertion point anywhere in the last

(blank) column, click the right mouse button, and

click Delete Cells. The Delete Cells dialog box

will appear.

1 1

.

Select Delete Entire Column, and then click OK
The surplus column will be removed.

12. Press CTRL+HOME.
13. Type appropriate field headings for each of the

fields. Your document should now resemble the

following

Name



Cacheman ° Windows 95/flT Freebie

The biggest fault of Windows95 is the disk cache

management. It takes almost all of the available

physical memory for speeding up the hard drive.

When the system runs out of RAM Windows

starts to use virtual memory instead of flushing

the caches. To change this crazy behavior you have

to edit the system.ini file. Cacheman is a GUI based

tool used to calculate the optimal cache size and

change the mentioned .ini file. The result is a much

better system performance especially on

computers with less than 64Mb of memory.

Cacheman is Copyrighted (c) 1997 by Thomas

Reimann. All rights reserved. (VERSION 1.0)

If you would like a copy of Cacheman the files

are available on the ISD Value Added Server at

\guest\windows\winaddon\95addons\
cacheman. If you don't access to the VAS,

contact Denny Knapp of End User Support at

444-2072, ZIP!, or e-mail at dknapp@mt.gov.

RFP/Contracts

Data Entry Services Contract with M.A.R.S. Stout

The current contract with M.A.R.S. Stout expiresJune

30, 1998. The original contract period was February

1, 1994 to June 30, 1995 and could be extended for a

total of five years ending February 1, 1999.

Agencies who currendy use or have used the contract

were surveyed in early March. Out of six agencies

currendy using the contract regularly, only Fish Wild-

life & Parks wanted ISD to rebid the contract. Two
agencies said not to rebid and three did not respond

to the survey. None of the three agencies using these

services on a periodic basis answered the survey.

For the sake of FWP, the contract will be renewed

through January 31, 1999, the maximum 5-year

extension period. Before expiration, FWP will conduct

their own rebid process, with assistance from ISD, to

get a data entry service provider.

Electronic Document Management and Imaging

Services (EDMIS) Contract

An Imaging planning meeting was held on March 18.

In attendance were the EDMIS Committee, ISD

Bureau Chiefs, the Contractor (KPMG-Peat Marwick)

and approximately 30 agency personnel. Discussion

included Fiscal Year 00/01 planning for imaging

systems, records management and the EDMIS term

contract. We also heard from several agencies about

their successful imaging projects. Anyone interested

in EDMIS planning and activities should call Brett

Boutin at 444-0515.

PC Term Contracts

The Compaq-Digital merger and term contract

With the upcoming merger of Digital Equipment

Corporation and Compaq Computer Corporation,

there are some concerns regarding the status of the

state's term contract for Digital PC products. We have

a letter from Digital offering assurance regarding our

Term Contract

The current term contract is renewable on an annual

basis, and is currendy renewed through May 1999.

Each year the contract is voted on to be renewed or

rebid. If the state chooses to continue renewing the

contract, it can only do so through May 2001. This is

the absolute end of the contract, and the state will

rebid the PC term contracts by then. Digital

Equipment Corporation has assured the state that for

the remaining renewable periods of the contract, the

state will continue to have Digital branded personal

computer systems available for purchase. Digital will

also continue to service any equipment purchases via

this contract for no less than five years after purchase,

subject to standard warranty terms and conditions.

For further questions contact Brett Boutin of the

Policy, Development and Customer Relations Bureau

at 444-0515, ZIP! or e-mail at bboutin@mt.gov.
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PowerPoint Made Casy!

Delivering presentations can be very stressful. Being

prepared, by having a concise message, can greatly

reduce that stress. Before putting content into your

presentation you may want to create an outline. You

can organize your thoughts by asking these simple

questions:

1

.

What is the purpose of this presentation? This

may sound simple, but it's important. Answering

this question can help you design slides that are

to the point. Without a purpose it's like playing

basketball without a hoop; you just run all over

the place and tire everyone out.

2. Who is the audience? Are they technical or non-

technical? Are they familiar with the subject or

do you need to give them the fundamentals first?

3. What do I want them to know or do after they

see my presentation? If you can imagine a

perfect reaction to your presentation, what would

it be? If, for example, you would like the audience

to start using Voice Mail, you would tell them the

benefits but you would also tell them how to get

training and sign up for it.

Text slides

Bulleted text slides should

not have a lot of words.

Think of them as highlights

that will augment what you

are saying. Don't try to put

your entire message, word

for word, onto the slide.

Resist the urge to use the

slides as notes for yourself.

Above all, do not read the

bullets to your audience. A good way to create bulleted

text is to write out, or outline your script, and then

take a highlighter and mark the words or phrases that

are the key points to your message.

Now that you know wfjy you are creating and delivering

this presentation, let's work on actually doing it.

We'll begin where we left off last month. Using any

of the methods described before, start PowerPoint,

open a blank presentation, and create a tide slide. Now,

we'll add to our presentation. After you've entered

the tide and subtitle, we'll create a bulleted text slide.

Do not read

the bullets

to your

audience.
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Dooking at Figure 1, find the cursor arrow pointing

to the New Slide icon. Click on the icon.

Notice that the bulleted text selection is already

highlighted.
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Click OK or double-click the highlighted icon. The

first bulleted slide is now ready for a tide and bullets.

There are many ways to enter the content. This is Slide

View, which shows you how your slides will look. You

can also use Outline View by clicking on that icon. In

Figure 3, 1 have put a rectangle around the area.
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The icons are, left to right, Slide View, Outline View,

Slide Sorter, Notes Pages, Screen Show. If you hold

the cursor over any icon in any Office application, its

name will appear. You can also choose these from the

View menu. For now let's work in Slide View.

Click inside the Tide box and enter a tide. Then move

your cursor to the Text box and click inside the box.

A good rule of thumb is the 7x7 rule. No more than

seven words per line, no more than seven bullets per

slide. After you have entered your text, let's create

another bulleted text slide. You have a few choices.

You could repeat the process, new slide etc. or you

could save a few steps by using the keyboard. Ctrl/

Shift/M will test your dexterity, but saves a lot of time.

Now you have a window that looks like Figure 2.

Another shortcut is to go to Insert
|
Duplicate Slide

or Ctrl+Shift+D. This is useful if you are making two

slides that are very similar because you can simply

modify the second one.

Enter another title and bulleted text. This time

intentionally misspell a word. You'll see a wavy red

line under the word. This will also appear if you have

spelled the word correcdy but have an extra space

between words. Or maybe you have entered something

the system doesn't recognize like an acronym or URL.

If the entire sentence is underlined it may be too long.

Place the cursor on the word and right-click the mouse.

Click on the correct spelling and it updates your slide.

This is a quick way to spell check as you go. Create

more text slides using the different methods described

then save the file, we'll work on it again next month.

Ways to Save

File
|
Save, select a drive and folder, then name it.

Click on the diskette icon (Second row from the

top, third icon from the left)

Ctrl\S

Next month we'll explore creating Organization

Charts.

For more information about this article contact

Trapper Badovinac of the Policy Development

& Customer Relations Bureau at 444-4917, ZIP! or

e-mail at tbadovinac@mt.gov. For user support,

contact the Customer Support Center at 444-2000.
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media Based Training [IDBT]

CO

What is a Gateway? How do Routers work? What is a

Tl line? What is a Relational Database? The answers

to these questions and much more is waiting for you

inside ISD's CBT/MBT library of courses. Most of

the courses will take only a few hours of your time.

They are self-paced so you can go back over any

section as many times as needed.

A VCR is needed. Most of the courses are

delivered on video, but some are multi-media on

CDROM. The information is presented in a

professional manner using various teaching

methods including diagrams and real life examples.

The accompanying workbook provides the course

in written form and after each section quizzes you

on what has been covered.

Sign up. Contact Trapper Badovinac or Diana

MacDonald via ZIP! to request a course. They

will need your name, phone number and agency.

Pickup. Courses are available in Room 222 of

the Mitchell Building, or we can deadhead the

course to you.

How Long? The checkout period for each course

is two weeks. It's important that you return your

course on time. These courses have become very

popular and there is a waiting list on many of the

courses.

What's Available? The course description of

each course can be found on the VAS at

guest\training\CT_Video\T3_VAS.rtf.

If you are an Approach user you can check on

the current availability of any course by accessing

the read-only file on the VAS at guest\training\

CT_Video \videodb.apr (password Montana).

How Much? There is no charge.

- Who is eligible? Any state employee.

Each month ISD News& Views will highlight a course

series and provide a description of its modules along

with degree of difficulty and prerequisites.

Course Series: Introduction to

Data Communication Networks

Course Code: 3.01.01

Course Title: Basic Elements of Data Communications

Basic Elements of Data Communications'will introduce you

to the components found in today's data

communications environment. You will learn about

the three basic elements in a data communications

network: the transmission medium, DCEs and DTEs.

The concepts of resource sharing, remote job entry

and downline loading, are also explored. You will see

the difference between a computing terminal and a

simple or dumb terminal. In the end, you will build a

basic communications system using these elements.

Prerequisites: A basic knowledge of the principle

of data communications.

Technical Difficulty: 12 3 4 5

Estimated completion time: 1 hour, 30 min (Video:

45 min + Workbook: 45 min)
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Course Code: 3.01.02 Course Code: 3.01.04

Course Title: Data Communications Hardware and

Software

Data Communications Hardware and Software explains the

role of computers in a network You will explore the

types of computers used and the differences between

them. The internal components of a computer,

including the CPU, memory and input/output devices

will be explained. Basic software components such as

the operating system, user applications and database

managers will be explained. In addition to learning

about the individual components, this course will show

how they work together to form a data

communications device.

Prerequisites: Basic Elements of Data Communications

(3.01.01)

Technical Difficulty: 12 3 4 5

Estimated completion time: 1 hour, 30 min (Video:

45 min + Workbook: 45 min)

Course Code: 3.01.03

Course Title: Binary Numbering System and Interchange

Codes

Computers are based on electronic circuits which have

two states: on or off. Hence, instead of using the

decimal system, computers use a much simpler

counting method. Binary Numbering System and

Interchange Codes will detail the steps involved in using

various numbering systems and code charts. You will

learn how to convert from decimal to binary and

hexadecimal numbers. You will also become familiar

with the terms bit, byte and word.

Finally, you will learn about interchange codes and

how the binary numbering system can be used to

represent the letters of the alphabet, numbers and

control information. You will understand the ASCII

coding system and how it relates to the EBCDIC and

Baudot coding systems.

Prerequisites: Data Communications Hardware and

Software (3.01.02)

Technical Difficulty: 12 3 4 5

Estimated completion time: 1 hour, 30 min (Video:

45 min + Workbook: 45 min)

lleuis °

Course Title: Data Transmission Concepts and Telephone

Lines

The most common transmission medium is the

telephone line since they are found practically

everywhere. This course introduces you to the basics

of data communications using existing telephone lines;

both switched and dedicated.

Regarding dedicated lines, the course covers point-

to-point, multi-point, and the idea of conditioning to

improve transmission. You will see how the central

office routes calls and the number of paths a call can

take. You will learn about 2-wire and 4-wire lines, as

well as simplex, half-duplex and full-duplex

transmission. The advantages and limitations of each

mode will also be discussed.

This course concludes by exploring some of the

transmission limitations of telephone wires based on

bandwidth, attenuation, noise and signal delay.

Prerequisites: Binary Numbering Systems and Interchange

Codes (3.01.03)

Technical Difficulty: 12 3 4 5

Estimated completion time: 1 hour, 30 min (Video:

45 min + Workbook: 45 min)

Course Code: 3.01.05

Course Tide: DTE-DCE Interface and RS-232-C

An interface manual is one of the most difficult

publications to read and understand. DTE-DCE
Interface and RS-232-C will give you a comfortable

understanding of the term "interface." It explains the

function of the RS-232-C interface in communication

between DTEs and DCEs. A discussion of each pin

in the RS-232-C connector will detail the types of

signals that are exchanged between DTEs and DCEs.

The course focuses on the most commonly used

interface signals and gives you an in-depth

understanding of their use.

After completing this course, you will be able to

understand the technical aspects of an interface

manual. RS-232-C or another type.

Prerequisites: Data Transmission Concepts and Telephone

lines (3.01.04)

thews

ra
ES
en

19



Technical Difficulty: 12 3 4 5

Estimated completion time: 1 hour, 45 min (Video:

45 min + Workbook: 60 min)

Course Code: 3.01.06

Course Tide: Concepts of Data Link Control

Concepts of Data Link Control cover how data

communications is very similar to the way that people

communicate over the telephone. The order in which

data is exchanged and the formalities involved in

sending a message from one computer to another is

referred to as a protocol. Most protocols include a

specification for data link control. This course will

explore the functions of data link control, including

framing, control and acknowledgments, error

detection and recovery. This course concludes with a

demonstration of how these functions are used during

data communications.

Prerequisites: DTE-DCE Interface and RS-232-C

(3.01.05)

=3 Technical Difficulty: 12 3 4 5

^ Estimated completion time: 1 hour, 30 min (Video:

es; 45 min + Workbook: 45 min)

S^ Course Code: 3.01.07

Course Tide: Start-Stop Data Link Control

This course will explain a specific data link control

communications protocol that uses Start and Stop bits

to control the transmission of data. You will learn

about parity bits and how they are used to detect

transmission errors. Synchronous and asynchronous

transmission are compared and the functions of RS-

232-C signals briefly explained. You will also be

familiarized with the advantages and limitations of

the Start-Stop DLC. This course concludes with an

in-depth example of Start-Stop DLC using ASCII
Control Characters.

Prerequisites: Concepts of Data Link Control (3.01.06)

Technical Difficulty: 12 3 4 5

Estimated completion time: 1 hour, 45 min (Video:

45 min + Workbook: 60 min)

For more information about this article contact

Trapper Badovinac of the Policy Development &
Customer Relations Bureau at 444-4917, ZIP! or e-

mail at tbadovinac@mt.gov.

Oracle Channel Classes

may

5 Designer/2000 Release 2 New
Features

6 Object Database Designer: An
Oracle8 Design Tool *PREMIERE*

7 PL/SQL 8 New Features

12-13 Oracle8 Architecture & Startup

1

4

Discoverer 3: Analyze Your Data

Requirements

19 Financial Applications Release 1

1

New Features *PREMIERE*

20 PL/SQL 1: Coding Techniques

21 L/SQL 2: Database Level

Application Programming

A full description for the each of the classes

can be found on the Oracle Web site at http:/

/education.oracle.com/education/toc.

Because class material has to be ordered you

must register at least two weeks before the

scheduled class date. Please contact Barbara

Clark at 444-0846, ZIP! or e-mail at

baclark@mt.gov.

***
0>e
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Computer Security

Training for Cnd Users

This is a two-hour seminar that covers the

following:

network security

laws, rules, and policies

login IDs and passwords

viruses, hoaxes, and chain letters

proper use of e-mail and the Internet

user responsibilities

This training is held the third Thursday of

each month from 8:30-10:30 am in room 13

of the Mitchell Building.

Date: Thursday, May 21

Time: 8:30-10:30 am

Location: Rm. 13, Mtchell Bldg

For registration or more information, please

contact Lois Lebahn (llebahn@mt.gov) or

Kim LaRowc (klarowe@mt.gov) of ISD at

444-2700.

Training Calendar

This schedule has been assembled by the

Helena College of Technology of the

University of Montana. If you have any

questions about enrollment, please call

444-6821. All classes will be held at the

Helena College of Technology at 1 1 15 N.

Roberts. Please note that these costs are

subject to change each July 1 st.

The Helena College of Technology makes

reasonable accommodations for any

disability that may interfere with a person's

ability to participate in training. Persons

needing an accommodation must notify

the college no later than two weeks before

the date of training to allow adequate time

to make needed arrangements. To make

your request known, call 444-6821.

To enroll in a class, you must send or

deadhead an enrollment application to

the State Training Center, HCT, Helena,

MT 59601. If you have questions about

enrollment, please call 444-6821.

Once you enroll in a class, the full fee will

be charged UNLESS you cancel at least

three business days before the first day

of class. HCT is also willing to schedule

specific classes by request from state

agencies.
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DOTE COST DPS

Data Base Classes

Intro, to Oracle

Prereq. Intro to Windows

Intro, to SQL
Prereq. Intro to Oracle

Oracle Developer 2000, part I

Prereq. Intro to Oracle & SQL

PL/SQL
Prereq. Intro to Oracle & SQL

Oracle Developer 2000, part II

Prereq. Oracle Dev. I & PL/SQL

Oracle Designer

Prereq. Oracle Dev. I; PL/SQL recommended

Lotus Approach
Prereq Intro to Windows

Access 97 for Light Users

Prereq Windows 95

Access 97

Prereq Windows 95

Data fletwork/fHamframe Classes

Windows 95 Archit., Instal., Sup. & Tuning

NetWare 4.x Administration

microcomputer Classes

Windows 95 Conversion

Prereq. familiar with Windows

Windows 95

ZIPlOffice

Word 97 Conversion

Prereq. Windows 95

Word 97 for Light Users

Prereq. Windows 95

Word 97

Prereq. Windows 95

Excel 97 Conversion

Prereq. Windows 95

Excel 97 for Light Users

Prereq. Windows 95

Excel 97

Prereq. Windows 95

PowerPoint 97

Prereq. Windows 95
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State Training enrollment Application

Complete IN FULL and return AT LEAST ONE WEEK prior to the first day of class.

Course Data

Course Request:

Date Offered:

Student Data

Name:

Soc. Sec. Number (for P/P/P):

.

Agency & Division:

Mailing Address:

Phone:

How have you met the required prerequisites for this course? Explain, giving the class(s) taken,

tutorial completed, and/or experience. =g
pa

Billing Information/Authorization Mandatory

User ID: Agency#: Authorized Signature:

If attending Oracle Developer or Designer training, your application must also be approved by

the agency IT Manager.

IT Manager __^____ _^_

Training is needed for:

] Agency Oracle Developer

I |
Continuing education opportunity. (Agency will be billed for training.)

~] Agency contractor. (Agency will be billed for training.)

Full class fee will be billed to registrant unless canceUation is

made three business days before the start date of the class.

DeadHead completed form to :

State Training Center

Helena College of Technology of the University of Montana

Phone 444-6800 FAX 444-6892

(lews ° Uieuis
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DeadHead Bach

Dept. of Administration

Information Services Div.

fAH Back

Information Services Div.

406-444-2701

mail Bach

Dept. of Administration

Information Services Div.

PO Box 200113

Mitchell Building, Rm 229

Helena, MT 59620-0113

Surf Bach

via Internet

ZIP! Bach

via ZIPIMail, ZlPlOffice,

TAO

Uisit the ISB Dews °

Uieais QJeb Site

www.state.mt.us/isd/

current/news/index.htm

editor's Ilotes

Published By

ISD News ei* I 'iews is published monthly by the Information Services Division (ISD),

Department of Administration, Room 229, Mitchell Building, Helena, MT 59620,

406-444-2700, FAX 406-444-2701.

This newsletter is dedicated to educating and informing the reader with pertinent State

technology news. Materials may be reproduced without permission. Alternative accessible

formats of this document will be provided upon request.

editorial Submissions

To submit an article to ISD News & Views for publication, send it to Trapper Badovinac,

preferably via ZIP!. Please have your article in by the 8th of the month for inclusion in the

following month's newsletter.

ISD Customer Support Center

Have a problem or opportunity? Do you need ISD assistance for any of your information

processing requirements? Then contact the ISD Customer Support Center (444-2000), which

is our central point of contact.

Subscription Services

ISD News <& Views is a free publication. If your name or address is incorrect, please send your

current mailing label along with any corrections to Trapper Badovinac. If you would like to be

added to our mailing list, let us know your name, agency, division, bureau, phone, address, city,

state, zipcode, and whether you would like your newsletter to be distributed via ISD Box #,

Deadhead or Mail. ISD News & Views is also available electronically via ZIP!/ZIP!Office or

VAX e-mail as well as the Web at www.state.mt.us/isd/current/news/index.htrri. Current

and back issues are located on the State of Montana Electronic Bulletin Board System (406-

444-5648 local& out-of-state, or 800-962-1729 toll free in Montana) and on ISD's Value Added
Server\guest\N&V.

Distribution Dotes

810 copies of this public document were printed at a cost of $600. Distribution costs are $18.25.

128 copies of this document were distributed electronically at no cost

Editor

Trapper Badovinac (444-4917), ZIP! or e-mail at tbadovinac@mt.gov. Layout Diana MacDonald

(444-3170), ZIP! or e-mail at dmacdonald@mtgov.

Department of Administration

Information Services Division

Mitchell Building, Room 229

P.O. Box 200113

Helena, MT 59620-0113

6127

Is Your Address Correct?
If not, see "Subscription Services..." above.

KAREN STREGE
MONTANA STATE LIBRARY
ADMINISTRATIVE SERVICES
1515 E6TH AVE
HELENA

MT 59620
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